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Introduction

The PhonEX MultiSite system is an integrated call management solution for
businesses that have more than one location (site). Typically each site in the
organization has its own PABX (sometimes more than one). These sites are
connected to one central system where all call data is concentrated. This
master system may also be directly connected to a PBX. An example of such
a system is a bank, that has branches in a number of locations and would like
to centralize the telemanagement of all of the branches, to one central
branch.

PBX

PBX

PBX

PBX

PBX

Central Site

Remote Sites

The master system uses fully parametric polling to remote locations.
MultiSite allows the telecommunication manager to monitor and control all
locations from one central location.
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In the PhonEX MultiSite system, a Site is a remote site where the PhonEX
program is collecting call data. The Center is a central location that
communicates with and collects data from all the Sites.

The Center is scheduled to retrieve data from Sites at given intervals. You
may configure these settings according to your needs.

The PhonEX MultiSite is easy to setup and use. Once data has been retrieved,
you may apply queries, produce reports, and display data using all of the
features available in PhonEX.
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Main Screen

Once MultiSite is installed on the computer at the Center, the MultiSite
program is initiated every time Windows is started. The main screen to the
MultiSite Center is displayed. This is the main interface for the MultiSite
Center. The Center displays the table of sites that has been defined for the
system, each with their status. This main screen also provides easy access to
the functions of the MultiSite program. The MultiSite main screen displays
the menus, toolbar, status, and table of sites.

The main menu includes the following:

 •  Site menu

 •  Configure Menu

 •  View Menu

 •  Help Menu

The Table of Sites displays each site that has been defined on the system.
Each site is described by its Status, Last Call field, and Next Call field.
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Status
Each site has a status that describes the state of the communication between
the site and the center. A site might have one of the following states:

Status Explanation

OK Communications are enabled and data is processed.

Failed Last call to Site not completed (no answer, no connection,
no data, no process).

Retry # The last call did not connect to the site and will be retried.
The retry number is displayed. When the retry number
exceeds the Number of Retries, the status is switched to
Failed.

Not Active This site is not currently active. The Site may be activated
via the Site - General Parameters dialog box.

Note A graphic representation of the status will appear next to this field,
making it easy to identify sites of similar status.

If the entire list of Sites is highlighted yellow, then all calls have been
blocked (Refer to Block Calls, page17).

Last Call
This displays the date and time of the last attempt to communicate with the
site.

Next Call
This displays the date and time of the next attempt to communicate with the
site.
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System Menus
Site Menu
Use this menu to:

Menu Option Description

Get Data Retrieve data from the highlighted Site.

Update Update the definition of the highlighted Site.

New Create a new Site definition.

Delete Delete the definition of the highlighted Site.

Exit Close the MultiSite application.

Configure Menu
Use this menu to:

Menu Option Description

Preferences Define Modem Parameters and Preference Parameters.

Block Calls Prevent any attempts to retrieve data from Sites.

Currencies Define multiple currency settings

View Menu
Menu Option Description

Sort Use option to sort the list of sites listed in the Main screen.

Help
Use this menu to:

Menu Option Description

Contents Access the application’s Help file.

About View the About information which includes the version
number of the program.
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What is a Site?

A Site is a remote location where the PhonEX program collects call data.
The MultiSite Center is the nerve center that communicates with and collects
data from each of the Sites.

Data is collected in one of the following ways:

 •  At regularly scheduled intervals.

 •  Immediate request to Get Data.

 •  Direct connection to PBX

Get Date
You may retrieved data from a Site anytime you want, by simply
highlighting the desired Site and pushing the Get Data icon. This will
initiate the communication process between the Center and the Site. Once
communication is established, new data will be retrieved from the Site and
added to its data base located at the Center.

Once call data is retrieved, the list of Sites will be updated. If there are
scheduled calls, they will be will resumed.

Update Site
The definition of each Site may be updated as required. First select the site
to be edited. Select Update from the menu, by selecting the Update Site
icon from the toolbar, or by pressing the right mouse button and choosing
Update Site from the quick menu. Refer to New Site, page 6 for an
explanation of these fields.

New Site
New Sites may be added to the system. A Site definition contains the
parameters that define the name of the Site, how to call, and when to attempt
to connect to the Site. Define a Site with the New command of the Site menu.

To define a new site, select New from the Site menu. The New Site dialog
box will be displayed. You must configure the following:
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 •  General

 •  Connection

 •  Communication

General
The General parameters include the name and target directory for the data.
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Fill in the following fields:

Field Explanation

Name: Site name.

Subdirectory: Name of subdirectory in which the Site PhonEX system is
installed (up to 8 character). This subdirectory must be
located under the application directory.

Code: Site code.

Connection

Type Automatic - The Center automatically calls the Site and
processes the data.

Manual - The user retrieves the data manually from the Site.

Direct file - The Center retrieves the data automatically
from a file.

Direct PBX - Connected directly to the PBX. Data is
received from the PhonEX line receiver.

Method Modem - Connect to the remote site via a modem
(telephone) connection according to the Modem
Parameters.

TCP/IP - Connect to the remote site via a TCP/IP layer
(network).
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FTP - Connect to the remote site via an FTP (File Transfer
Protocol) connection

Active Status of the Site ( Active,  Disabled)

Connection
The Connection parameters describe the frequency and preferred times to
retrieve data.

Fill in the following fields:

Field Explanation

Frequency Frequency of contact to the site in hours.

Preferred Time Preferred time to contact the Site.  This parameter is
applicable only if the Frequency is 24 hours (or a multiple
thereof).

You may specify times when not to make scheduled calls. Set the hours that
the MultiSite Center should not call the sites by selecting the hours for each
day of the week on the weekly table. Calls that are scheduled to occur during
a “Don’t Allow Calling” time, are rescheduled to the beginning of the next
hour. You may still manually Get Data even if the current time is marked no
to allow calling.
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The table is arranged where each row is a different day of the week, and each
column is an hour of that day. The hour will be marked in red to indicate that
the site will not be called during that block of time for the given day. Hours
marked in white indicate times that the site may be called to retrieve data.

Hours are marked using the mouse. A click on the table will toggle the select
hour between Allow Calling and Don't Allow Calling. Additionally, you can
select a block of time by dragging open an area on the table.

You may select a row by pressing the row label, or a column by pressing the
column label. Rows and columns will toggle all of the hours based on the first
hour in the selected part of the table.

Communication
The Communication parameters describe the connection settings that are
specific to the given Site. The Communication dialog box displayed depends
on the Connection Method selected in the General panel (refer to Connection
(Type, Method), page 8). If you are connecting through a network (TCP/IP),
the following dialog box is displayed:

Communication (for TCP/IP)

Fill in the following fields:

Field Explanation

Password The password for the Site. The password is not case-
sensitive. This password must match the Site password or
connection to the Site will not be enabled.
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TCP/IP Settings

IP Address Enter the network IP of the Site.

Site Port Specify the port used by WinSite at the designated location.

If you are connecting to the site via a modem, the following dialog box is
displayed:

Communication (for Modem)

Fill in the following fields:

Field Explanation

Password The password for the Site. The password is not case-
sensitive. This password must match the Site password or
connection to the Site will not be enabled.

Modem Settings

Number Enter the number to dial for the designated site.

Baud Rate This setting is used to specify the Baud Rate (connection
speed). Select Default to apply the standard Modem settings
(refer to Modem, page 13). To override this setting, select
the baud rate to be used with the designated site.
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If you are connecting through an FTP connection, the following dialog box is
displayed:

Communication (for FTP)

Fill in the following fields:

Field Explanation

User Name The user name for the FTP site.

Password The password for the FTP site. The password is not case-
sensitive. This password must match the FTP site password
or connection to the FTP site will not be enabled.

FTP Settings

Server Name Enter the server name of the FTP site.

Remote Path Type the remote path used at the designated FTP site.

Type the file name to be downloaded.

Delete A Site
Delete a Site by selecting it and choosing Delete from the Site menu. The site
and all of its relevant definitions will be deleted.
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Configure

Define the following preferences which describe the mode of communication
with the Sites.

 •  Modem

 •  Parameters

Modem
These modem settings describe the default settings to be used by the Center,
unless otherwise specified.

Note The modem communication parameters must match those of the
modem at the Site.
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Fill in the following fields:

Field Explanation

Port The COM port of the Modem.

Baud The speed of operation to be used.

Parity The parity setting for the modem.

Data Bits The data bits setting for the modem.

Stop Bits The Stop bits setting for the modem.

Name The type of Modem installed. If your modem doesn’t
appear select a compatible modem or define a new
definition.

Modem

Name Enter the name of the modem being used by the Center.

Prefix The prefix may be used when dialing a site. This feature is
most often used in offices to obtain an outside line (i.e. 9,).
The prefix is used in Sites that apply the Use Prefix option
only.

Press the Settings button to modify, add, or delete a modem definition.

Press the Test button to perform a series of tests between the modem
definition and the modem itself.

Test Modem
This function performs a series of tests that validates the integrity between the
modem definition and the modem itself. The modem tests the following:

1. Is the selected COM port available?

2. Does the modem respond to initialization commands?

3. Does the modem respond properly to the selected configuration?

The test may display an error if there is a problem with one of these tests.
This may indicate a problem with the port or with the modem definition. If
the modem passes all of the tests, a message will be displayed.
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Predefined Modems
The PhonEX MultiSite Center is stocked with a large number of modem
definitions. Simply choose the modem that you have from the list, update an
existing definition, or create a new definition for the modem at the Center.

Parameters

These parameters are connected to the frequency of communication and
describe the MultiSite’s handling of retries when a Site can not be properly
reached.

Fill in the following fields:

Field Explanation

Minimum delay After
Call (Min)

The minimum delay in minutes between calls.
Default is 1 minute

Number of Retries The number of times to retry connecting to the Site
before the status of the Site becomes Failed.

After No Connection
(Min)

The minimum delay (in minutes) before a retry,
after no connection failure.
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Field Explanation

After Disconnect
(Min)

The minimum delay (in minutes) before a retry,
after a disconnect failure.

After No Data (Min) The minimum delay (in minutes) before a retry if
no data is received.

After No Process
(Min)

The minimum delay (in minutes) before a retry if
data collected from a Site has yet to be processed.

After a No Connection, Disconnect, or No Data, a retry will be scheduled
until the Number of Retries has been exceeded. At this point the Site will be
assigned the Status, Failed. The next attempt to connect will be according to
the Site Connection parameters.

After a No Process, retry will continue to schedule a connection to the Site
until data is processed.
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Block Calls
This function allows you to easily place all connections on hold until you are
ready to begin receiving data. Blocking Calls does not affect Site settings.
Select this option from the Configure menu.

While calls are blocked, the list of Sites will be highlighted in yellow. You
will not be able to manually collect data.

Selecting this option again will remove the block on calls. Sites that are active
will return to being active and Sites that are not active will remain not active.

Currencies
The PhonEX Pro system allows you to work in multiple currencies. This
easy-to-use feature is vital in today's global economy. In order for you to be
able to work in multiple currencies, your PhonEX Pro system must be
configured for multiple currencies when it is installed.

When you first begin working with PhonEX Pro, no currencies are defined.
The first currency which you define becomes the main currency. The main
currency is identified by a panel on the upper left of the Currency Table.

Note: Once you define the first currency, you cannot delete it or make any
other currency the main currency.
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The PhonEX Pro system allows you to redefine currency rates on a monthly
basis. Reports and graphs generated for a particular currency automatically
use the rate you have defined for that currency, relative to the main currency,
for the month covered in the report.

To define currencies, select Currencies from the Tools menu. The Currency
Table dialog box for the current month is displayed:

Currency Table dialog box

Adding New Currencies
Click New to add a new currency. The Add New Currency dialog box is
displayed:

Add New Currency dialog box
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If you have not yet defined any currencies, the Currency Table will be empty.
In that case, when you click New to define the first currency, you will be
prompted to confirm that this currency will be used as the main currency,
according to which all calls are calculated. Click OK to confirm.

The following fields are displayed:

Code: Type a code used to identify the currency. For example, type US for
United States dollars. The code can include up to 4 characters.

Symbol: Type a symbol used to identify the currency. For example, type $
for dollars. The symbol can include up to 4 characters.

Description: Type a description of up to 20 characters. The description is
usually the plural of the currency name, as in "US Dollars".

Decimal Digits: Type a numeric value for the number of digits to which
values are rounded off. For example, to display 13.6499 as 13.65, type 2.

Rate: Type the value of the new currency, relative to the main currency. For
example, if the new currency is worth twice as much per unit as the main
currency, type 2. When you define the main currency, this value is 1 and
cannot be edited. The code for the main currency is displayed below this
field.

After you enter data, click OK to save the new currency, or Cancel to close
the dialog box without making changes.

Updating Currencies
To update a currency, select the currency to be updated, and then click
Update. The current information for that currency is displayed in the Update
Currency dialog box. Modify the information as required, and then click
OK, or click Cancel to close the dialog box without making changes.

Deleting Currencies
To delete a currency, select the currency to be changed, and then click
Delete. You will be prompted before the currency is deleted. Click Yes to
delete the selected currency, or No to retain the table as is.
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Viewing and Editing Other Months
The green right and left arrows on the dialog box enable you to move from
one month to the next. Click the right arrow to advance to the next month.
Click the left arrow to return to the previous month. You cannot advance to
a future month.

The PhonEX Pro system allows you to redefine currency rates on a monthly
basis. If you try to view a month for which exchange rates have not yet been
defined, you will be prompted to confirm that you want to define exchange
rates for that month. Click Yes to confirm. Once you define exchange rates
for a month, all reports and graphs for that month automatically use the
exchange rates you have defined.

To redefine exchange rates for a month, select each currency in the table and
update its rate. If you do not redefine exchange rates, the table will display
the exchange rates defined for the following month.
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View

Sort
You can organize the list of sites that are displayed in the main screen. The
list may be organized so that you can easily view the information that is
important to you. To sort the list, select the View menu and then select Sort.

Choose one of the following sorting methods:

Custom
You can specify the exact order of each site by moving the site up or down
the list. Select the site to be moved. Select Move Up or Move Down
accordingly.

Note This function is only available when the Custom Sorting method is
used. When the Custom setting is selected, the Move Up and Move Down
functions are available from the quick menu that is displayed when pressing
the right mouse button.

By Name
This option will sort the list of sites, alphabetically by the name of the site.

By Status
This option will sort the list of sites according to the status of the site. All
failed sites will be listed first, next sites that have an OK status, and finally all
sites that are inactive.

Last Call
This option will sort the list of sites according to the time the last call was
placed. Calls are listed from most recent to least recent.
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Help

On-line help is available from the main menu bar. Additionally, you can
receive immediate help from the MultiSite On-Line Help tool by pressiy" the
F1 key or the Help button located on most dialog boxes. You will see
instructions, explanations, or an index of topics you can choose from. A topic
in Help is similar to a page in a book.

If you find a Help topic you will want to refer to again, you can mark it with a
bookmark. Choose the Define command from the Bookmark menu in Help,
and type a name for the bookmark. Next time you want that topic, choose its
bookmark from the Bookmark menu, and the topic will be immediately
displayed. A complete description of the help system can be found in the
Microsoft Windows User Guide.

Within the main on-line Help menu, there are several other features:

 •  For instructions on using Help, choose How To Use Help from the Help
menu.

 •  For a list of major Help subjects (like the table of contents in a book),
choose Content from the Help menu; then choose the subject of your
choice. You will see a list of specific topics you can choose from.

 •  For an alphabetical list of keywords (like the index in a book), choose
the Search button any time the PhonEX Help window is displayed. Click
or type the keyword you want, and press <Enter> to display a list of
Help topics related to the keyword. Then choose the desired topic.

 •  Copyright information also appears under the Help menu selection.
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